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Spreadsheet definition:
A spreadsheet stores and manipulates data that lends itself to being stored in a table type format
(e.g. Accounts, Science Experiments, Mathematical Trends, Statistics, etc.).  The sheet is divided into
rows and columns. Each entry box defined by one row and column together e.g. B3 is called a
cell. When you start working in Excel, you begin using a workbook that contains screens called
worksheets. As you become more familiar with the available options in Excel, you can customize the
menus and add buttons to the toolbars.

Starting a New Excel Worksheet:

Right Click the Desktop and move the pointer to New and click on the Microsoft Excel
Worksheet. A new "Microsoft Excel Worksheet" icon appears on the desktop. Rename the file
Practice. Double click on the Workbook document. If necessary, click the Maximize button on
the worksheet.

•  Click on any one of the MENU items. You should see a window showing what you can do under that
menu. Click anywhere back on your document to close this window 

•  Place the pointer on one of the toolbar icons and wait for a few seconds. The icon's function will
be revealed. A fuller description of the icon's function can be seen on the status bar at the
bottom of the screen 

Navigating Through an Excel Worksheet

There are a number of ways to move around in a worksheet. Moving from one cell to another in Excel is
quick and easy. The ways to move from cell to cell include clicking a cell or using the Go To command,
the scroll bars, the arrow keys, or the HOME, END, PAGE up, and PAGE DOWN keys.
Moving within a window

1. To select any cell, click it. For example, click cell Al.
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2. To move one cell to the right, press TAB, or to move one cell to the left, press SHIFF+TAB.

3. To move one cell down, right, up, or left, use the arrow keys.

4. To move to the first column of the worksheet, press HOME.

Moving from window to window

1. To move one window down, press PAGE DOWN.

2. To move one window up, press PAGE UP.

3. To move to the uppermost-left cell, Al I press CTRL+HOME.

4. To move to any cell, on the Edit Menu, click Go To, and type J18 or any cell number.

5. Press CTRL+HOME to return to cell Al.

Note
There is a difference between a workbook and a worksheet. A workbook can contain many worksheets.
Each worksheet can contain up to 256 columns across and 65,536 rows down.

Moving from one end of the worksheet to the other:

1. Press F5, or Control  + G to open the Go To dialog box. Enter a cell address and move quickly to

any area of the worksheet or any page of the workbook.

2. Press Control + Home to return to cell A1 from any area on the active worksheet.

3. Press the End key, then an arrow key to move to the far edges of the active worksheet.

4. The Name Box at the far left in the formula Bar displays the active or selected cell.

5. Click one of the tab scrolling buttons in the lower left-hand corner of the excel window to move

quickly from worksheet to another in the workbook.

6. You can press the Page Up and Page Down keys to move up or down one page. Press Control + Page

Up to move to the next worksheet and control + Page down to move to the previous worksheet.
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ENTERING DATA

A cell can contain text, numbers, or a formula. When you start the program the cursor is resident in

cell A1. 

•  Type in the heading as shown below and press Enter. 

 (Note how the cells merge to contain all of the data.) 

•  Enter the rest of the data as shown above. 

•  Use the arrow keys to move from cell to cell 

(Note that if using the arrow keys it is unnecessary to press Enter after entering information.)

 Excel will automatically left justify all text entries and right justify the numbers. 

SAVING WORK

When you create a workbook, regardless of which method you use, you must save your work in a logical

place on the computer. When we started the program we created a new Workbook document on the

desktop but if we had not then you would need to save the document at some time. Just like filing a

document in a file drawer, storing a computer document requires some attention to how you name the

document and where you place it so you can easily find it again. Files can be saved to a floppy disk, to

an individual computer hard disk or to your own area on the network.
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To save your work to a floppy disk 

•  From the Standard Toolbar select the SAVE icon  

•  In the filename box: Type A and a colon in front of your filename then press Enter e.g. 

A:MYSHEET. EXCEL will

automatically label your

file as an Excel file by

adding the suffix .XLS to

your filename 

Editing a Worksheet:

To make changes to fonts or to delete the contents of the cells, for example, select a contiguous

group of cells or ranges from different areas. Excel allows you to use the Control key for this purpose.

Row and Column headings are the row numbers

or column letters used to denote each row and

column. Selecting an entire row or column is as

simple as clicking its row or column heading.

You can use the  shift-click technique to easily

resize the selection of a large area. Click the

upper-left corner of the area, hold shift, then click the lower right cell of the range. Hold Control and

select separate cells or ranges to select non-contiguous Blocks as seen above.
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Inserting additional Columns and Rows:

Click in cell B2. To Insert a row Click and drag on Insert and

drag to Columns and Select it. A new column is added. To

Delete a row or column, Select Edit and drag to delete.  A

dialog box will appear as seen to the right. Select entire

column. The column is now deleted.

Formatting our Spreadsheet:

In our Spreadsheet example we will now have our spreadsheet calculate totals for the rows and

columns. The values we get will require formatting to make the spreadsheet easier to understand.

Excel allows you to apply numerical formatting styles easily.

If you enter a label that exceeds the column's default width, the text appears in the adjacent empty

cells but is truncated at the edge of the column if nearby cells contain any entries. The solution to

this is to widen the columns, so that entries display properly.

Another great feature of Excel is the AutoFill feature, which places a logical progression of values or

labels in a series of cells. An example of this would be the months. If you enter the months in your

spreadsheet such as Jan, Feb, March etc., you do not have to type all that information. Just select the

cell containing the first entry, then click and drag the AutoFill handle found on the lower-right corner

of the cell selector. Excel will complete the entries for you.

You can move cell contents by highlighting the desired cell; place the pointer on the edge of the cell

until it becomes a left tilting arrow, and click and drag the outline to a new position.
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Double clicking on the column-heading separator will AutoFit the column or you can choose the Auto fit

Selection from the column submenu found on the Format menu. Excel automatically updates the column

width for numerical entries.  If you wish to Center The title Label as in our example you must select

the cell you wish to Merge and Center. In

this case it is cell A1. Now click on the

Merge and Center Icon. Now the title

will merge into the amount of cells it

needs. This is a good time to experiment

with formatting changes. Click a cell that

contains a label or data and click the bold

button and try making changes to fonts and

sizes. We can also rotate text labels by

selecting the cells we wish to rotate which

in this case are the months, January,

February, March and April. Right click on

the Highlighted area and select Format

Cells. Click the Alignment Tab. Double click

the Degrees field. Type 15 and click OK.

Your months should now be tilted 15

degrees. In the "Format Cells" dialog box you also have the ability to Wrap Text, Shrink to fit as well

as merge and unmerge cells.

Highlight the numerical data and click on the currency Style Button. All the numerical data  should now

have the currency style applied to it. Let us Close our worksheet for now.
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Using AutoFormat

You can use Autoformat to apply predefined formats to your spreadsheet. The process is easy.

•  Open the file we have been working with

•  Select the area of the spreadsheet you want to format

•  Choose a predefined format from the AutoFormat dialog box.

•  A sample area displays

how the format will

affect the selected

range.

•  After applying a

format, click outside the spreadsheet to view the changes.

Using a Template:

Excel comes with a set of Templates, These are already formatted and are designed to handle a

variety of business and financial tasks. You can reformat these templates to suit your own tastes. The

templates can be used repeatedly.

•  You must first select the New option from the file menu to access a template. Excel comes with 4

templates. Let us open the purchase order template.

•  To demonstrate how this works click the display example/remove example

button.

•  Make some changes to the unit Prices to see how the total column changes.

•  Scroll through the Worksheet and Press Control + Home.

•  Close the Purchase Order example without saving.
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To print the selected sheet

Reopen our example we have been working with.

•  From the Standard Toolbar select the PRINT icon  

•  To print an area of your sheet  Highlight the area you want to print as follows 

•  Move the cursor to the cell at one corner of your area 

•  Click and hold down the left button on the mouse 

•  Keeping the button depressed drag the mouse to the bottom right corner of your area 

•  Release the button. (Click and drag) 

•  From the menu select File 

•  Select Print 

•  You will see 

•  Print What?

•  Before we make a selection let's

click on Preview. From here we can see

exactly how our spreadsheet will look

when it is printed out. We also can

choose to make adjustments by going to

Setup. Click on Set up and this dialog

box will appear. From this box you can

make changes in the page orientation,

Margins, Header and Footers and Sheet preferences. You can choose to Center your data from the
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Margins page.

Saving an Existing Workbook

Saving an existing file to the same file name, location, and format

1. On the File menu, click Save.

2. Click OK.

3. Close the workbook.

Reminder: Saving to a different location and changing the file name unless you specify otherwise,

Excel 97 will save all files to a default sub-directory on your computer called My Documents.

Opening Files, Entering and Copying Formulas

To Open and Existing Spreadsheet file from floppy disk

•  Open Excel 

•  Place the Floppy Disk in the diskette drive 

•  Double click on the Excel icon using the left button of the mouse 

•  Click on the File Open icon i.e.  

•  You will see 

•  Click on the select button and choose the A drive 

•  You will see something like: 

•  Double Click on your saved file,

which should load 
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•  The opened spreadsheet should display data something similar to below.

ENTERING A FORMULA

Formula cells create calculations on the contents of other cells (e.g. Totals or Averages). All formulas

begin with an = sign. The result of the calculation is seen in the cell. The formula can be seen in the

Edit bar where it can be altered if needed.

To enter a formula 

Example 1: Adding up a column

•  Select cell A8 - move to it with the mouse and click in the cell.  Enter the word TOTAL . Then 

Either 

•  Move to cell B8. Click on the cell. 

•  Enter = SUM(B4:B7) and press

Enter 

•  From the toolbar Select .

This symbol means, "Sum of". 

•  Press Enter 

•  You will see: 
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•  Example 2: Averaging a Column

•  Move to cell A9. Enter the word "Average" 

•  Move to cell B9. Enter = AVERAGE(B4:B7) press return 

•  B9 should show the average of the three items in column B   The Edit Bar should display the

formula.

Fill Commands:

You can use either the fill commands or the AutoFill feature to enter similar formulas in dozens or

hundreds of cells. The 2 fill commands, Fill Right and Fill Down, place a copy of a formula into cells to

the right of or below the cells to the right of, or below the cell in a selected range. The cell must be

adjacent or continuous. Before using, the fill commands select the desired range. You must start the

range with the cell containing the formula at the top-left corner of the range, not with the blank cell

to the right or below it. You can also use the AutoFill feature to insert formulas into smaller

spreadsheets The AutoFill handle is located in the lower right-corner of the cell selector. Dragging it

to the adjacent cells, automatically fills them with a logical progression of formulas, labels, or values.

Example Copying the Summing Columns formula to all four columns

•  Move the cursor to cell B8 

•  Place the cross of the pointer on the AutoFill handle or COPY HANDLE (small square on the

bottom corner of the cell) The pointer should change to a small black cross. 

•  Click and hold down the left button on the mouse.  Keeping the button depressed drag the

mouse across row 8 up to E8. Release the button. (Click and drag). C8 to E8 should contain the

results of the formulae SUM (C4: C8) to SUM (E4: E8). This form of copying is called

RELATIVE REPLICATION - notice how the formula has changed in each column.
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•  Use the same technique to copy the formula in cell B9 to C9, D9 and E9 to work out the

average for each column. 

The equivalent formula for summing column B needs to be replicated in cells C8 to E8. It is very

common to require a repeating formula in a spreadsheet, so Excel makes it easy for us by using a

technique called a AutoFill or COPY HANDLE.  The value of any cell or groups of cells can be copied in

this way. Try it with units of time or anything that has a pattern.

Creating Absolute References:

There are three types of cell references: Relative, Absolute and Mixed. Excel formulas use relative

referencing by default. Absolute Reference are indicated by the dollar sign ($) preceding the row or

column designation. Absolute references do not update when copied or moved. They reference the

same cell address, no matter where the formula is in the worksheet. So if I were to copy the formula

=C10/$B$9 one cell to the right, the new formula becomes =D10/$B$9. Only the relative part of the

formula changed; the absolute reference remains fixed on a specific cell address.
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CHARTS
The easiest way to produce charts in Excel is by using the Chart Wizards.  The full Chart Wizard icon

appears on the Standard toolbar. Selecting this icon takes you through a series of very simple screens

in which you create a graph of your choice from the area you have highlighted.  The Default Column

Chart Wizard icon (On the Chart toolbar) creates a column chart directly from your highlighted area. 

To Create a Simple Column Chart using the Chart Wizard:

•  Load the file we saved. 

•   Click and drag the mouse from cell A1 to E6.

•  From the TOOL BAR Select Chart Wizard  

•  A series of Chart Wizard prompt screens will appear: 

•  Chart Wizard: Select Line as the type of Chart

and click Next

•  You now have a choice to select whether to plot

the data across rows or columns. For our example

choose rows. Now click Next.

•  Enter a Chart Title: Enter SALES  for 1st

Quarter. Y-axis: Enter PROFIT  and X-axis

should be Month. Click on Next.

•  The next dialog box allows you to decide on a chart location,

You can have it on a separate sheet of its own or as an

object on the spreadsheet. Choose new sheet.
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Click here to
change the options
on the tool bar

Editing an Existing Chart:

A chart remains an embedded object after it is placed on its own sheet. This means any changes in the

spreadsheet data series are automatically replotted in the chart.

To easily make  editing changes to our chart go to the view menu and drag to tools. Click on Chart. You

should now see a Chart

tool bar similar to the

right. The Chart and

other toolbars can be

switched on and off using

the View Menu. 

Experiment by making

several changes. You can include your data table in the chart sheet as well as make many changes in

the look of the chart.  It is very easy to change your column chart to some other form e.g. Line Graph,

Bar and 3D pie chart. The difficulty is not in creating charts - but to be able to select the right type

to display the information you have!! 

Rotate A Chart:

In order to rotate a chart, you must have a three-dimensional chart type; Excel cannot rotate a two-

dimensional chart.

•  Display a 3-D pie chart of our data from our example

•  Click on the Chart menu and drag to and release on 3-D View

•  The 3-D view dialog box appears
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•  You can now experiment

by making changes to

control elevation, rotation

and perspective of the

view of the chart. If you

decide you don't like any of the changes you can always click on the default button to restore the

chart's original position and angle. You can click on Apply without closing the #-D view dialog box.

Other Options to Explore:

For emphasis, try exploding, or separate a specific slice from the remaining slices of the pie. You

simply select the slice you want, then drag it away from the pie. You can apply Data Labels to value,

percent, labels or a combination of labels and percent.

Editing Chart Features and Details:

Some elements of your chart may need editing, eg; colored lines and fills may not show up well when

printed in black and white. 

To edit chart features:

•  Click once within the area of the chart to select it.

•  Double-click on lines or bars on the chart to open Format Data Series prompt boxes: 

Here you can edit the pattern, style and color of the line or bars and several other options covering

the source of the data, and the arrangement of the axes. Note that when you change the pattern of a

line or bar, the legend will change to match it.

•  Double-click on words or axis labels to Format Axis: 

From here you can format the pattern, scale font, number and alignment of labels and legends.
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Create a map

If you don't see the Map button  , rerun the Setup program to install Microsoft Map. If you decide

you like and want to use this function on your computer you will need to rerun the Office setup

program if you do not have the Map feature available.

Guidelines for setting up data to create a map

•  When you create a map, the first step is to set up and select the data you want to display.

Arrange the information in columns on a worksheet. One column must contain geographic data, such

as the names of countries or states. Use the table below as your data.

State Sales in Millions

CT 5

CA 25

TX 15

AR 3

If your worksheet contains additional data for each map feature, such

as sales figures for each country, include that data in the cells you

select to create the map. If there are headings at the top of your

columns, include those headings in the selection.

Tips

•  To see a list of standard spellings and abbreviations for map features, see the sample workbook

Mapstats.xls in the Data folder within the folder for Microsoft Map.

•  If your data contains numeric postal codes, such as U.S. ZIP Codes, make sure the postal codes

are formatted as text, not as numbers. Formatting postal codes as text prevents the removal of

zeros that might be part of a ZIP Code number.

•  To create a map that shows map features and associated data, select a range of cells on your

worksheet that includes geographic data, such as countries or states.

•  Do not select a range to  create a map that shows only map features with no data.
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•  Click Map

•  On the worksheet, drag a rectangle of the size and shape you want.

•  If prompted, select the map you

want to use. In this case we will

choose North America without

Hawaii or Alaska.

•  Microsoft Map Control Dialog box

will appear. After selecting the

Options desired such a shading click

on the close button and your changes

will be visible on the map.

•  The Map Tools are now available to make changes to the Map.

You can delete some areas on the map by double clicking on the map. For example, if you didn't want

Canada you can remove it from your Map completely. This is a good time to explore this by making

changes using the Map tools.
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SORT A LIST ON A SINGLE CRITERIA

Information in a list can be sorted in ascending or descending order, based on the values in a single

column (or row) or several columns (rows).

Note: all columns (rows) in a list must be included in the sort. Otherwise any data omitted will

remain in the same sequence.

To sort a list using a single criteria

•  load the file we saved

•  highlight cells A4 to E6 (we only want to sort the data, not the headings or totals)

•  Click on the ascending sort icon 

•  The data will now be sorted, by column A values, in ascending order

•  To sort in descending order, click on the descending sort icon  

•  If you make a mistake with your sort, select Edit, Undo Sort immediately

.


